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ANOTACIJA

Metodisko materialu sagatavoja Tana Grafova, Rasma Homatova, Janis Pavlovskis,
Marija Sjomina — 2022./2023. macibu gads. Praktisko macibu uzdevumu un vértéSanas
kriteriju izstradne I kursam Iespieddarbu noformesanas tehnika profesija.

Digitalie macibu materiali miisdienigai macibu satura apguvei — patstavigo darbu
uzdevumi iespieddarbu maketu noformesana un sagatavosana iespieSanai.

Darbs sastav no 20 praktiskiem uzdevumiem 144 macibu stundam, vértéSanas
krit€rijiem, uzdevuma izpildei nepiecieSamajiem failiem. Pievienotas izstradatas video
pamacibas un metodiskie materiali.

Metodisko materialu mérkis ir nostiprinat audzeknu zinasanas, iemanas un prasmes,
kas iegiitas teorctisko nodarbibu un macibu prakses laika. Parbaudot péc izstradatiem
vertéSanas krit€rijiem var secinat, vai macibu merki ir sasniegti. Svarigi ir laikus sniegt
atgriezenisko saiti ikdienas macibu procesa, svarigi ir tas, ka katra darbs ir pamanits un, kas
biitu jadara, lai audz€knis savu sniegumu uzlabotu.

Praktisko macibu ikdienas darba uzdevumi apkopoti Rigas Valsts tehnikuma Drukas
un mediju tehnologiju nodalas e-macibu vidé Moodle dmtn@rvt.lv atseviska sadala — Prakse:
Iespieddarbu noforméSana 1. Materiala ietvertie Prakses macibu uzdevumi iespieddarbu
noform@Sana un sagatavosana iespiesanai ir savstarpgji saistiti, secigi no vienkarsaka uzdevuma
uz sarezgitaku, apgiistot prasmes un iemanas Adobe grupas programmas — InDesign,
[lustrator, Photoshop, Acrobat.

Uzdevumu gaita var noveértét audzéknu zinasanas, iemanas un prasmes par
iespieddarbu maketu grafisko noformesanu un sagatavoSanu iespieSanai, ka ar1 audzeknu spgju
analiz€t sava darba rezultatu un uzlabot ta kvalitati. [zstradatie uzdevumi nodros$ina individualu
pieeju, kas ir svarigs nosacijums kvalitativai izglitibas nodroSinasanai, skolotajs var realizet
radoSu un diferenc€tu pieeju macibu procesa planosana un istenosana.

Darbs paredzets Drukas un mediju tehnologiju nodalas skolotajiem un citiem
interesentiem, lai planotu pedagogisko macibu darbu. Metodiskais materials izmantojams
profesiju konkursu organizéSanai profesionalas izglitibas iestades, kuras apgiist izglitibas

programmu lespieddarbu noform&juma tehnikis, atbilstosi 3. kvalifikacijas limenim.



1. METODISKA MATERIALA
TEORETISKAIS RAKSTUROJUMS

Darba tirgus attistibas tendences Latvija un citas Eiropas Savienibas valstis liecina par
strauju tehnologiju attistibu. Arvien pieaug vajadziba péc augsti kvalificEtiem specialistiem,
kuri sp&tu izmantot jaunakas tehnologijas.

Digitala pratiba ir biitiska ikdienas dzives sastavdala un digitalas tehnologijas veicina
elastigu un pieejamu macibu procesa nodroSinasanu.

Profesionalaja izglitiba notiek parmainas izglitibas procesa un satura, kas saistitas ar:

e modularo profesionalas izglitibas programmu ieviesanu;

e iespgju atgriezties profesionalaja izglitiba pec partraukuma, kompetencu atzisanu;
e ilgtspgjigas attistibas principiem (resursi, tehnologijas, zalas prasmes);

e picauguso izglitibas nozimigumu mizizglitibas konteksta;

e saiknes veidoSanu ar realam darba vides situacijam, problémsituaciju risinasanu;
e darba vidg balstitu profesionalas izglitibas programmu Tpatsvara pieaugumu.

Notiek izmainas ne vien profesionalas izglitibas satura, bet mainas ar1 izglitibas
ieguves formas, palielinas attalinato macibu ipatsvars. Digitalas prasmes palidz kvalitativi
apglt macibu saturu. Svarigi ieverot izglitojamo maciSanas ipatnibas, jaunakas tendences
nozaré, pasvaditas maciSanas iesp&jas. Tapec profesionalaja izglitiba nepiecieSami macibu
lidzekli, kas atbilst miisdienigas profesionalas izglitibas prasibam gan péc satura, gan formas.
Digitalie macibu lidzekli ir viens no instrumentiem, ka veicinat izglitojamo paSvaditu
macisanos un profesionalas kvalifikacijas apguves motivaciju. [1]

Nodro$inot profesionalas izglitibas iestazu izglitojamajiem kvalitativus macibu
lidzeklus, tiek radita iesp&ja pasvadita macibu procesa veidot nepiecieS§amo zinasanu, prasmju
un kopgjo attieksmju kompetences izveletas profesionalas kvalifikacijas vai modulu apguve.

1 https://www.visc.gov.lv/lv/media/19689/download?attachment



https://www.visc.gov.lv/lv/media/19689/download?attachment

1.1. Radosas inovacijas pieejas raksturojums

Macibu procesa viens no visnozimigakajiem aspektiem ir izglitots un radoss cilveks.
Misdienas darba devéji galvenokart izv€las darbiniekus, kam piemit paSizpausmes un
personiskas izaugsmes motivacija, radosa izt€le un pieeja dazadu problému risinasana.

Radosa domasana nav talants, ta ir prasme, kuru var apgiit ikviens, ta ir mérktiecigas
darbibas rezultats. Ta ka radoSuma pamata ir procesi, kas rosina dazadu variantu kombinaciju
problémas risinasanai, tad bitiskas ir arl zinaSanas un pieredze. PamatzinaSanu un
pamatprasmju apguve dod iesp&ju efektivak izmantot ikviena radoSo potencialu. RadoSums ir
priekSnoteikums, lai rosinatu jauniesus atverties un uzdrikstéties, biit nepartraukta mainiba un
attistiba.

Piedavajam jaunieSiem instrumentus un materialus, laujam paSiem eksperimentet,
kludities un izveleties vislabako variantu, veidot izstradajumu noteiktam mérkim vai noteiktai
personu grupai (problémsituacija — ir jarékinas ar adresata vecumu, mentalitati).

Iespieddarbu noform&juma tehniki radosi izstrada dizainu dazadiem iespieddarbiem,
iecer un veido zimola identitati, noformé vizitkartes, bukletus, plakatus, iepakojuma dizainu,
gramatu noform&jumu un vizualas reklamas materialus.

Uzdevumus izstradajam misdienu jaunieSiem interes€josa un pieejama digitala vide,
uzsveram teorétisko zinasanu pielietojumu praktiskajas macibas, skaidri un saprotami noradam
uzdevuma izpildes secibu, radoSai izpausmei piedavajam video un metodiskos materialus,
dazada dizaina paraugus.



2. PRAKTISKAIS METODISKAIS MATERIALS

2.1. Metodiska materiala praktiskais raksturojums

Metodisko materialu izstradné tiek piedavati praktisko macibu uzdevumi ar izpildes
gaitas secibu, konspekti, video pamacibas, uzdevumu izpildei nepiecieSamie materiali, uzskates
lidzekli, tehniskie macibu lidzekli, ko izmanto informacijas ieguvei, izpratnes veidoSanai un
padzilinasanai patstaviga darba izpildei macibu procesa (teksts, attéli, logotipi, dazadi paraugi,
pieméri u. c.).

Atbilstosi iesp&jam sagatavojam macibu procesam un darba IstenoSanai piemérotu un
pieejamu darba vidi:

e atsaucigas savstarp&jas attiecibas;

e veicinam patstavigu macisanos, kas balstita pasizzina un pasnovertgjuma;

e pieejamu atbalstu par macibu saturu;

e pielagota fiziska vide un resursi.



2.2. Metodiska materiala pielietojums izglitibas joma

Metodiskais materials veidots ka atbalsts skolotajiem praktisko macibu darba
istenoSanai gan klatienes, gan attalinato macibu procesa organizéSana iespieddarbu
noform&juma tehnikiem un digitalas drukas operatoriem.

Katrs izglitojamais mérktiecigi plano uzdevuma izpildes laiku, tad€jadi dodot iesp&ju
attistit sava snieguma sasniedzamo rezultatu apguveé neatkarigi no esosa apguves limena, lai
saprastu, ko jau sp&j paveikt un kas ir nakamais limenis uz kuru virzities.

Pedagogs Tsteno uzraudzibu un sadarbibu ar izglitojamo, kas ir bitiska visa macibu
procesa IstenoSanas gaita.

Ta ka prasmes veido darba novértéSanas saturisko pamatu, tad tas nosaka vertésanas
formas un krit€rijus. Vertg§jam sniegumu pret planotajiem sasniedzamajiem rezultatiem,
izmantojot summativo vertésanu, un izvirzito macibu mérku sasniegSanai, izmantojot formativo
vertéSanu.



3. IZSTRADATO UZDEVUMU
UN VERTESANAS KRITERIJU VARIANTI

3.1. Stundas uzdevums: BroSiiras maketeSana péc parauga.

Stundas meérkis: Veidot prasmes un iemanas att€lu sagatavoSana maket€Sanai,

brosiiras maketa radosa noformésana Adobe InDesign programma.

10.

11.

12.
13.
14.

Uzdevuma izpildes laiks — 7 macibu stundas

Uzdevums un veérteSanas Kkriteriji:
https://dmtn.rvt.lv/moodle/mod/assign/view.php?id=4388

Uzdevuma norades un izpildes gaita:

. Brosiiras papira formats 145 x 170 mm, atvéruma/Facing Pages ar automatisko teksta

logu/Primary Text Frame.

Skatit video pamacibu: https://www.youtube.com/watch?v=2Q8hEUaxDrU

Iestati krasu parlaides Bleed 5 mm. Stila lappusés A-Parent sadali lappuses 9 % 9 laukumos.
Izveido salikuma spoguli péc pievienotas pamacibas.

Izveido automatisko lappusu numeraciju:

(Cmnd + Option + Shift + N vai Ctrl + Alt + Shift + N)

Ievieto maketa tekstu File > Place.

Skatit video pamacibu: https://www.youtube.com/watch?v=uKfilR4-IGM&t=15s
Piesleédz tekstu pamatliniju tiklam/Baseline Grid.

Sagatavo att€lus Photoshop programma:

att€lu izméers, iz8kirtsp€ja (300 ppi), krasu telpa (CMYK), fails (TIFF).

Ievieto sagatavotos att€lus maketa, Text Wrap atdali tos no teksta ar rindas starpinajumu
15,2 pt. Skatit pielikuma materialu par att€lu ievietoSanu. Attelus var ievietot ar1 pa visu
salikuma spoguli.

Izveido rindkopas/Paragraph stilu pamattekstam: Calibri, 12 pt burtu biezne, 15,2 pt
rindu starpindjums/Leading, rindu slégums Left Justify, atkape 6 mm.

Skatit video pamacibu: https://www.youtube.com/watch?v=z2GoiPM5ttTQ&t=378s
Izveido rindkopas/Paragraph stilu virsrakstam: 12 pt burtu biezne, pustrekniem,
versaliem/4ll Caps burtiem, rindu starpinajums 15,2 pt, Space Before atdali to no
nepiederosa teksta ar diviem rindu starpinajumiem 30,4 pt un Space After no tam piederosa
teksta ar vienas rindas starpinajumu 15,2 pt.

Pielieto izveidotos rindkopu stilus.

Failu iesniegSana:
Izveido: File > Package (fonti, atteli, atvertie faili, IDml, PDF).
Atseviski sagatavo PDF failu, atzimgjot Spreads — lappusu atvérums.
Augsupielade: PDF failu un InDesign Package ZIP arhiva.
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https://dmtn.rvt.lv/moodle/mod/assign/view.php?id=4388
https://www.youtube.com/watch?v=2Q8hEUaxDrU
https://www.youtube.com/watch?v=uKfilR4-IGM&t=15s
https://www.youtube.com/watch?v=zGoiPM5ttTQ&t=378s

Uzdevuma izpildei nepiecieSamie faili:
— 1_Gaujas_nac_parks.jpg
= 2_Slitere.jpg
3_Kemeri.jpg
— 4 _Smardes_stacija_11.jpg
= 5_Ainazi.jpg
6_Liepaja.jpg
7_Amata.jpg
& Latvijas_karte.tif

—

—

—
L |

Metodiskais materials:
-] attelu_ievietosanas_varianti.pdf

| Brosuras_maketesanas_darba_gaita.pdf
¥ Celojumi_paraugs.pdf

Vertesanas Kriteriji:

Maketa tehniskie parametri — max. pt. 9

Brosiiras papira formats, atvérums, automatiskais teksta logs 3pt
Bleed krasu parlaides 2 pt
Lapas sadalijums, Margins malu noteikSana 4 pt
Attelu sagatavosana, ievietoSana maketa — max. pt. 10
Attelu izmérs, iz8kirtsp&ja 3 pt
CMYK krasu telpa 2 pt
Att€lu faila formats — TIFF 2 pt
Text Wrap atdaliti no teksta ar rindas atstarpi 3pt
Teksta maketéSana — max. pt. 16
Teksts pieslégts pamatliniju tiklam/Baseline Grid 3pt
Lappusu numeracija ievietota un atdalita no salikuma spogula 2 pt
Izveidots korekts rindkopu stils pamattekstam un pielietots 2 pt
Izveidots korekts rindkopu stils virsrakstam un pielietots 2 pt
Virsraksti ir atdaliti no teksta pareizi 2 pt
Vardu parnesumi ir pareizi 2 pt
Lappuse nesakas ar rindkopas p&dg€jo rindu (izkapes rindu) un nebeidzas | 3 pt
ar atkapes rindu
Failu iesnieg§ana — max. pt. 4
PDF/x4 ir atseviski augSupieladéts ar lappusu atvérumu, apgriesanas 2 pt
krustiem, krasu parlaidem
Package (fonti, atteli, atvertie faili, IDml, PDF) 2 pt



https://dmtn.rvt.lv/moodle/pluginfile.php/9757/mod_assign/introattachment/0/1_Gaujas_nac_parks.jpg?forcedownload=1
https://dmtn.rvt.lv/moodle/pluginfile.php/9757/mod_assign/introattachment/0/2_Slitere.jpg?forcedownload=1
https://dmtn.rvt.lv/moodle/pluginfile.php/9757/mod_assign/introattachment/0/3_Kemeri.jpg?forcedownload=1
https://dmtn.rvt.lv/moodle/pluginfile.php/9757/mod_assign/introattachment/0/4_Sm%C4%81rdes_stacija_11.jpg?forcedownload=1
https://dmtn.rvt.lv/moodle/pluginfile.php/9757/mod_assign/introattachment/0/5_Ainazi.jpg?forcedownload=1
https://dmtn.rvt.lv/moodle/pluginfile.php/9757/mod_assign/introattachment/0/6_Liepaja.jpg?forcedownload=1
https://dmtn.rvt.lv/moodle/pluginfile.php/9757/mod_assign/introattachment/0/7_Amata.jpg?forcedownload=1
https://dmtn.rvt.lv/moodle/pluginfile.php/9757/mod_assign/introattachment/0/Latvijas_karte.tif?forcedownload=1
https://dmtn.rvt.lv/moodle/pluginfile.php/9757/mod_assign/introattachment/0/attelu_ievietosanas_varianti_N1.pdf?forcedownload=1
https://dmtn.rvt.lv/moodle/pluginfile.php/9757/mod_assign/introattachment/0/Brosuras_maketesana_darba_gaita.pdf?forcedownload=1
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Atgriezeniska saite (daZi piemeéri):
Teksta Rindkepu stilu
maket&sana: izstrade
B Teksts pieslégts pamatiiniju tklam 3 points Clizveidots korekts rindkopu stils 3 points Aff apaksvirsrakstam
Baseline Grid virsrakstiem un pielietots nedrikst piclaut dalit
P wvardus, nedrikst
- izidzingt uz pilnu
B Lappusu numerdcija ievietota un 2 points platurmu .
atdallta no salikuma spogula
Bizveidots korekts rindkopu stils, 3 points Meathilst atkdpes
i pamattekstam un pielietots lieduirns
Clzveidoti korekti rindkopu stili, 2 points Tracking nedrikst likt A
pamattekstam un pielietoti ~ -
lieldku par 20f1000 B Teksts pieslegts pamatiiniju tiklam 3 points
el Baseline Grid
B 1zveidoti korekt rindkopu stili 2 points ¥ei
s T el B virsraksti ir atdaliti no teksta pareizi 2 paints
P
B virsraksti ir atdaliti no teksta pareizi 2 points 4
B vardu parnesumi ir pareizi 2 points
P
B vardu pdrnesumi ir pareizi 2 points
Blappuses nesdkes ar rindkopas padéjo 2 points
rindu
A
£
B Lapa nesakas ar rindkopas pédéjo 3 points.
rindu (izkapes rindu) Atkartot informaciju par atkapes veidoSanu:
https:/[dmtn.nvtiv/moodie/mod/lesson/view php?id=26H&pageid=147
A IVirsrakstu rindkopu stilos vienmér jGotsledz vardu dafisana — Hyphenate.
Atstarpju izmainifanas soli starp simboliem Tracking jaiestata pirms uzsakt
teksta moket@Sanu — Edit » Preferences > Units&increments » Keyboard =
Increments » kerning/Tracking — 5/1000 em (v 1. 5 tdkstoddalas no burta 'm” Group peints: 12/15
platumal.|
Group points:14/16
Attélu Rindkopu stilu
sagatavoiang, lzstrade
ievietodana O tzveidots korekts rindkopu stils virsrakstiom un - 3 points | Gatsiadz vardy
pielietols 3
B CMYK krasu telpa 2 points Qond
P
5 lzveidols korekts rindkopu stils, pamattekstam 3 points \Vardu dasanas
4 "
un pielielots ierobezojums/Limit
Dizékirtspéja dpoints  [374n17. Ipp. neatbilst jalie 2
i 2 alkape noatbilst
g
P
B Tekets piesiagls parmatiniju tkiam Baseline 3 points
B Faila formats tiff 2 points Grid
]
el B Virsraksti ir atdaliti no teksta pareiz 2 points
& Attgli atdaliti no teksta ar rindas 3points  [precrak jaatdala 5
atstarpi =
P Vardu parnesurmi ir parelz 2 points
4
B Attélu ievietogana atbilst neteikumiem 3 points A
B Lappuses nesakas of rindkopas padajo findu 2 pointe
P
P
Alkdriol Iﬂ!OH“l’:I‘_‘,iJLI par alkdpes veidosanu:
hitps:/ [dmtrrvLivimosdle/mod/lesson/view php?id =2641&pageid=147
Skalit pielikumu par makelétanas noteikumiem Maketesanas_noleikumipdl
hitps:/ fdmitn v moodie/mod| assign/view php?id =4389
] P

Group points: 10/13

Group points: 12/15
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Titullapa

Titullapa

Teksta noforméjuma pielietots vienots 2 points B Teksta noforméjuma pielietots vienots 2 points
stils stils
4 A
Burtveidoll saskanoti ar virsraksta, 2 points D Burtveidoli saskanoti ar virsraksta, 2 points Teksts nav iziasdms,
inicidla stilu iniciala stilu POF WUMEU UZ IUMEas
F krasas fona P
levietotie grafiskie elementi saskanotl 2 points  [\yaiistot valodal B levietotie grafiskie elementi saskanoti 2 points
ar grématas saturu un citiern attéliem neatbilstosus ar grdmatas saturu un citiem attéliem
burtus/fontu P P
Skatit titullapu — "IZDEVNIECTBA, netabilstodas garumzimes| Jdieskatds krésu mécibas plerckstos
vajadZigo KONTRASTU var sasniegt, izmantojot dazadas nokrdsas un
jadzig T fegt, i jot dazéad krd
tumurna - gaisuma attiecibas.
g
Group points: 6/6 Group points: 4/6
Lappusu
numerdcija
= = Failu iesniegSana:
lzveidota automatiski 1 points
CIPDF/x4 ir atseviski augsupieladéts ar 2 points Nav lappusu atvérums
Ipp. atvérumu, apgrieéanas krustiem,
] kréisu parlaicém
4
Burtu biezne un burtveidols atbilst 2 paints 5 S N
o : Package (fonti, attél], atverte fail, 2 points
gramatas teksta stilam
Dmi, PDF)
P

O IzlidzinGta ar salikumea spogula armalu 2 points
un atdalita ne pamatteksta

O Lappusu numerdcija iznemta no tam
lappus&m, kurds tai nav jabit

1 points

No pamatieksta nav
atdalita

ievietofanu:

Skatit pielikurmu — Ipp_numeracija2.pdf — par lappusu numeracijas

https:/{dmtnrvtiv/moodie/mod/assign/view php?id=4399

Group points: 3/6
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Pages » Spreads

sagatavejot grématu produkeijas PDF failus, [Gatzimé lappusu atverums

Group peints: 2/4




3.2. Stundas uzdevums: Izveidot fotogramatu
par pasaules valstu galvaspilsetam.

Stundas merkis: Veidot prasmes un iemanas att€lu sagatavosSana, broSiiras maketa
radosa noformé&sana Adobe InDesign programma.

Uzdevuma izpildes laiks — 7 macibu stundas

Uzdevums un vérteSanas kriteriji:
https://dmtn.rvt.lv/imoodle/mod/assign/view.php?1id=6052

Uzdevuma norades un izpildes gaita:
. Izv€lies gramatas izméru (no A5 lidz A4 izm&ram).
. Nosaki lappusu baltas malas péc Grid vai diagonalu principa.
. Izveido radosu titullapas noform&jumu, atbilstosi gramatas nosaukumam — Galvaspils&tas.
. 2. lappusi atstaj tuksu.
. Interneta samekl@ attelus, kur redzamas atbilstoSo pasaules valstu galvaspilsétas. Attéliem
jabut kvalitativiem. Var mekl&t ar1 unsplash.com
6. Attelus ievieto gramata atbilsto$i nosacijumiem (skatit pielikuma: att€lu ievietoSana),
ieverojot visa maketa vienotu stilu.
7. Attelus sagatavo Photoshop programma:
e vajadzigaja izméra;
e ar atbilstoSu krasu telpu CMYK;
o izSkirtsp&ju 300 ppi;
e faila formats TIFF.
8. Zem atteliem ievieto att€lu parakstus, att€lus numurgjam 1. att., 2. att. utt. (pieméram,
1. att. Riga, Latvija).
9. Attelu aprakstu no att€la atdali ar nelielu atstarpi (2 mm).
10. Attelus ievieto p&c noraditiem variantiem:
e pa visu salikuma spoguli;
e uz apgriezumu,
e divi atteli vienas lappuses salikuma spoguli.
11. Maketa jabut 24 lappusém.

DA W -

Failu iesnieg§ana:
1. Izveido: File > Package (fonti, attéli, atvertie faili, [Dml).
2. Atseviski sagatavo PDF failu, atzimgjot Spreads — atveérums.

3. Augsupielade: PDF failu un InDesign Package ZIP arhivu.

Uzdevuma izpildei nepiecieSamie faili:

= attelu_ievietosana_fotogramata-01.jpg
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https://dmtn.rvt.lv/moodle/mod/assign/view.php?id=6052
https://dmtn.rvt.lv/moodle/pluginfile.php/12319/mod_assign/introattachment/0/attelu_ievietosana_fotogramata-01.jpg?forcedownload=1

Vertesanas Kriteriji:

Izveléts gramatas | Darbs izpildits | Darbs izpildits Darbs izpildits | Darbs izpildits
formats, kvalitativi, kvalitativi, viduvgji, tas ir | vaji, tas ir
noteiktas atbilstosi visam | atbilstosi lietojams tikai | lietojams tikai
malas/Margins, tehniskajam tehniskajam pec labojumu | p&c nozimigu
atbilstoSas krasu | prasibam prasibam, ir veikSanas labojumu
parlaides — 20 punkti nelielas 8 punkti veikSanas
max. pt. 20 neprecizitates 4 punkti
16 punkti
Titullapas Darbs izpildits | Darbs izpildits Darbs izpildits | Darbs izpildits | Darbs ir
noforme$ana — | radosi, kvalitativi, viduvgji, tas ir | vaji, tas ir uzsakts, bet
max. pt. 20 atbilstosi visam | atbilstosi lietojams tikai | lietojams tikai | uzdevums nav
tehniskajam tehniskajam pec labojumu | péc nozimigu | izpildits
prasibam prasibam, ir veikSanas labojumu 2 punkti
20 punkti nelielas 8 punkti veikSanas
neprecizitates 4 punkti
16 punkti
Izveidots Darbs izpildits | Darbs izpildits Darbs izpildits | Darbs izpildits | Teksts ir
rindkopu kvalitativi, kvalitativi, viduvgji, tas ir | vaji, tas ir ievietots, stils
stils/Paragraph atbilstosi visam | atbilstosi lietojams tikai | lietojams tikai | nav izveidots
Styles parakstiem | tehniskajam tehniskajam pec labojumu | péc nozimigu | 2 punkti
zem attela — prasibam prasibam, ir veikSanas labojumu
max. pt. 16 16 punkti nelielas 6 punkti veikSanas
neprecizitates 3 punkti
12 punkti
Attelu Darbs izpildits | Darbs izpildits Darbs izpildits | Darbs izpildits | Darbs ir
sagatavo§ana — kvalitativi, kvalitativi, viduvgji, tas ir | vaji, tas ir uzsakts, bet
max. pt. 20 atbilstosi visam | atbilstosi lietojams tikai | lietojams tikai | uzdevums nav
tehniskajam tehniskajam pec labojumu | péc nozimigu | izpildits
prasibam prasibam, ir veikSanas labojumu 2 punkti
20 punkti nelielas 8 punkti veikSanas
neprecizitates 4 punkti
16 punkti
Failu Darbs izpildits | Darbs izpildits Darbs izpildits | Iesniegts tikai
iesnieg§ana — kvalitativi, viduv@ji, tas ir vaji, tas ir viens no
max. pt. 16 atbilstosi visam | lietojams tikai lietojams tikai | failiem
tehniskajam pec labojumu péc nozimigu | 2 punkti
prasibam veikSanas labojumu
16 punkti 8 punkti veikSanas
4 punkti
max
N punktu
skaits
0.92
o TEKIIEm & =1
— — — ™~ 2] <t =] - o0 53 =N = = =N z
| vertéjums balles 1 2 3 8 9 10
- pukuskas | 1] 13] 14[ 27] 28[ 40 76| 77 84| 85[ 88| 89 92
| izpildesmenis % | 1] 14] 15[ 20] 30] 44N SIEIEZINGINE] 76| s3] 84 o1 9] 96 97] 100]
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3.3. Stundas uzdevums: Brosiras «LatvieSu valoda» maketéSana,
salikuma spogula noteikSana, Ipp. numeracijas ievietoSana InDesign
programma.

Stundas merkis: Veidot prasmes un iemanas att€lu sagatavoSana maket€Sanai,
brosiiras maketa radosa noformésana Adobe InDesign programma.

Uzdevuma izpildes laiks — 7 macibu stundas

Uzdevums un vérteSanas kriteriji:
https://dmtn.rvt.lv/moodle/mod/assign/view.php?id=6050

Uzdevuma norades un izpildes gaita:

Darba izmérs: 150 x 210 mm (atzimé&t Primary Text Frame, Bleed);

Atver stila lappusi A-Parent, sadali stila lapu 9 x 9 rindas un slejas.

Izveido salikuma spoguli, nosaki Margins malas: sac ar Inside.

Stila lappus€s izveido lappusu numeraciju CTRL+SHIFT+ALT+N.

Abu lappusu teksta ramjus pielago salikuma spogula izm&ram.

Ievieto doto tekstu. Pieslédz pie pamatliniju tikla/Baseline Grid. Noradi rindu

starpinajumu 15 pt.

Radosi noformé izdevuma titullapu.

8. Izveido sakuma 3. lappus€ augsbalstu — atkapi no salikuma spogula augSas 1/3—1/4-dalai.

9. Izveido pamatteksta rindkopu stilu, pielieto (burtu biezne 12 pt, rindu starpinajums 15 pt).

10. Izveido virsraksta rindkopu stilu, pielieto.

11. Interneta samekle saturam atbilstoSus vismaz 3 att€lus, sagatavo Photoshop programma,
ievieto broStras maketa, atdali att€lus Text Wrap ar rindu starpinajumu — 15 pt.

12. Augsupieladé Moodle PDF failu un Package.

SN B0 g N

5=

] attelu_ievietosana Briva.pdf

W darba_teksts brosura_valoda21 03.docx

] lpp_numeracija2.pdf

B8 tituli E.pdf
] titulu_varianti.pdf
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https://dmtn.rvt.lv/moodle/mod/assign/view.php?id=6050
https://dmtn.rvt.lv/moodle/pluginfile.php/12317/mod_assign/introattachment/0/darba_teksts_brosura_valoda21_03.docx?forcedownload=1
https://dmtn.rvt.lv/moodle/pluginfile.php/12317/mod_assign/introattachment/0/lpp_numeracija2.pdf?forcedownload=1
https://dmtn.rvt.lv/moodle/pluginfile.php/12317/mod_assign/introattachment/0/tituli_E.pdf?forcedownload=1
https://dmtn.rvt.lv/moodle/pluginfile.php/12317/mod_assign/introattachment/0/titulu_varianti.pdf?forcedownload=1

Vertesanas Kriteriji:

Tehniskie parametri — max. pt. 7
Darba formats atbilst uzdevumam 1 points
lestatits lappuSu atvérums 1 points
Atziméts automatiskais teksta ramis 1 points
Krasu parlaides atbilst gramatu produkcijai 1 points
Malu noteikSana péc rezga uzstadiSanas 3 points
LappuSu numeracija— max. pt. 6
Izveidota automatiski 1 points
Burtveidols atbilst gramatas teksta stilam 2 points
IzI1dzinata ar salikuma spogula armalu un atdalita no pamatteksta 2 points
Lappusu numeracija iznemta no tam lappusém, kuras tai nav jabiit 1 points
Rindkopu stilu izstrade — max. pt. 15
Izveidots korekts rindkopu stils virsrakstam un pielietots 3 points
Izveidots korekts rindkopu stils pamattekstam un pielietots 3 points
Teksts pieslégts pamatliniju tiklam/Baseline Grid 3 points
Virsraksti ir atdaliti no teksta pareizi 2 points
Vardu parnesumi ir pareizi 2 points
Lappuses nesakas ar rindkopas p&dgjo rindu un nebeidzas ar rindkopas 2 points
pirmo rindu
Titullapas noformé$ana — max. pt. 6
Teksta noform&juma pielietots vienots stils 2 points
Burtveidoli saskanoti ar virsraksta, iniciala stilu 2 points
Grafiskie elementi saskanoti ar gramatas saturu un citiem attéliem 2 points
Sakuma un beigu lappuses — max. pt. 3
Augsbalsts atbilst nosacijumiem 2 points
No beigu lappusém iznemti lappuSu numuri 1 points
Attelu sagatavoSana, ievietoSana — max. pt. 13
CMYK krasu telpa 2 points
Atbilstosa izSkirtspeja 3 points
Faila formats .tiff 2 points
Atteli atdaliti no teksta ar burtu bieznes atstarpi 3 points
Att€lu ievietoSana atbilst noteikumiem 3 points
AugSupielade — max. pt. 4
Package (fonti, atteli, atvertie faili, PDF) 1 points
PDF lappuSu atvérums ar griezuma linijam, krasu parlaidem 3 points
max
N  punktu
skaits
| 034
fommt ppecyiom E z E z E E E z E z E z E z| 8
X B &) & § 2 5 &l B 3 S| Bl B B &
— 2 3 7 8 9 10
| pukuskars | 1] 7,1] 8,1 15] 16[ 41[ 44| 45 49| 50 51| 52| 54
| izpildes imenis % | 1] 14] 15[ 20] 30[ 44 SSITIGINGEINE]  7s[ s3] s4] o1] 92] 9] 97] 100]
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SECINAJUMI UN PRIEKSLIKUMI

Darba izvirzitais merkis ir sasniegts. Ir izveidots daudzveidigs uzdevumu klasts, kuros
var praktizeties ar poligrafiju saistito izglitibas programmu izglitojamie.

Sos praktiskos uzdevumus iespieddarbu noformétaju skolotaji var izmantot macibu
stundas, nostiprinot I kursa izglitojamajiem prasmes un iemanas. Papildus var izmantot
prezentacijas, videopamacibas, maketéSanas noteikumu metodiskos materialus.

Darba izvirzitie uzdevumi ir izpilditi. Katrs izglitojamais var analiz€t savu attistibas
gaitu un izpildita uzdevuma praktisko pielietoSanu.

Macibu materialu var izmantot informacijas ieguvei, izpratnes veidoSanai un
padzilinatai patstaviga darba macibu procesa organizéSana.

Skolotaji un jebkuras grupas izglitojamie, kuru macibu plana ietilpst iespieddarbu
noforméSana, var lietot uzdevumiem pievienotos pielikumus.

Uzdevumi ir aktuali, tie nepartraukti tiek atjaunoti, redigéti, papildinati. Tiesi tapat tiek
redigéti, papildinati vertésanas kriteriji.

Miisu ieteikums biitu laicigi atjaunot programmu licences, uzlabot un uzturét materiali
tehnisko bazi darba kartiba.
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